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1. Select and prepare resources 

1.1 – Adjust workspace, furniture and equipment to suit own ergonomic, 
work organisation and work health and safety (WHS) requirements  
 

Ergonomic requirements may include: 

 Avoiding radiation from computer screens 

 Chair height, seat and back adjustment 

 Document holder 

 Footrest 

 Keyboard and mouse position 

 Lighting 

 Noise minimisation 

 Posture 

 Screen position 

 Workstation height and layout 

Work organisation requirements may include:  

 Exercise breaks 

 Mix of repetitive and other activities 

 Rest periods 

Any assessment of ergonomic conditions that exists in the workplace would normally be handled 
through the HR (Human Resource) department under a Risk Assessment as part of WHS (Work 
Health and Safety) or by a system that evaluates risk potential to employees. 

Some of the areas suggested in the Range Statement would be more suitably handled by employees 
as part of a daily or periodic self-check of equipment, the workstation and work area before work 
commences and during work. 

Example Self Check List 

Question Response/Action 

Are you keying and using mouse activities 
interspersed with a variety of other work tasks? 

 

Do you include pauses such as deliberate breaks 
to reduce stress and tension? 

 

Do you conduct regular pause exercises during 
computer operation at least every hour? 
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Do you alter your posture when seated, stand or 
move throughout the day? 

 

For areas that may be covered under WPH&S and awards or Human Resource policies, responsibility 
of the employer to provide a safe workspace would be documented and form part of regular risk 
management checks. 

 Supervisors, managers, team leaders etc. are generally designated WHS officers so 
that there is a standard and policy driven culture present to the checks. 

 Responsibilities include hazard reporting procedures, job procedures and safe work 
instructions, emergency procedures, accident and near miss reporting and 
recording procedures, consultation on WHS issues, correct selection, use, storage 
and maintenance procedures for use of personal protective equipment, control of 
risks under direct supervision. 

 Awareness of relevant legislation from all levels of government (State or Federal) 
which affect business operation, especially in regard to WHS and environmental 
issues, equal opportunity, industrial relations, anti-discrimination and diversity. 

 Compliance to behaviour that contributes to a safe working environment, 
identifying and reporting risks or hazards, using business equipment according to 
guidelines, listening to the ideas and opinions of others in the team, sharing 
opinions, views, knowledge and skills. 

 Formal and informal health and safety meetings, meetings called by health and 
safety representatives, suggestions, requests, reports and concerns put forward to 
management. 

 Workstation height and layout, chair height, seat and back adjustment, footrest, 
screen position, keyboard and mouse position, document holder, posture, avoiding 
radiation from computer screens, noise minimisation. 

 Mix of repetitive and other activities, rest periods, exercise breaks, VDU eye testing. 

 A range of environmental conditions including; noise, light, gas, smoke, odour, 
vapour, liquids/solids, particles and fumes. 
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If a particular office layout design is needed this would be a matter of personal and working 
circumstances. 

For example: 

 Does the workspace provide acoustical privacy (for example, can people talk in 
privacy, according to the level of confidentiality required; do noises and 
conversations interfere with their concentration; do noises or conversations make it 
difficult to hear or understand speech if much of 
their work involves using the telephone?) 

 Are the walls permanent (i.e., fixed) or is the 
workspace in an open office environment? 

 Does the workspace provide visual privacy? 

 Can an employee personalise his or her 
individual work space? 

 Is there access to natural light or only artificial 
lighting? 

 Is the workplace layout designed to facilitate interpersonal contact? 

Examples of workplace policy requirements 
 Maintain work areas in a safe, uncluttered and organised manner according to 

policy and procedures. 

 Carry out all procedures safely, effectively and efficiently with minimum 
inconvenience to staff according to policy. 

 Apply policy and procedures for tidying work areas and placing items in designated 
areas. 

Clean work area 

 Apply policy and procedures for personal hygiene. 

 Apply policy and procedures for cleaning of work area. 

 Sort, recycle, remove and dispose of waste promptly according to policy 
requirements. 

 Safely remove and clean spills of food, waste or other potential hazards in 
compliance with WHS requirements and policy. 

 Maintain equipment and consumable materials and store correctly after use. 

 Use and clean equipment according to manufacturer instructions and policy 
requirements. 
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Consideration should be given to: 

 The accessories required to operate properly 

 The layout of equipment on the desk 

 The location of furniture in the room 

Work surface height 

 Adjust the height of the work surface and/or the height of the chair so that the 
work surface allows your elbows to be bent at 90 degrees, forearms parallel with 
the floor, wrist straight, shoulders relaxed.  

Chair 

 Adjust the seat tilt so that you are comfortable when you are working on the 
keyboard. Usually, this will be close to horizontal but some people prefer the seat 
tilted slightly forwards. Your knees should be bent at a comfortable angle and 
greater than 90 degrees flexion. If this places an uncomfortable strain on the leg 
muscles or if the feet do not reach the floor then a footrest should be used. The 
footrest height must allow your knees to be bent at 90 degrees. Therefore the 
height of the footrest may need to be adjustable. Adjust the backrest so that it 
supports the lower back when you are sitting upright. 
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Keyboard placement 

 Place the keyboard in a position that allows the 
forearms to be close to the horizontal and the 
wrists to be straight. That is, with the hand in line 
with the forearm. If this causes the elbows to be 
held far out from the side of the body then re-check 
the work surface height. Some people prefer to 
have their wrists supported on a wrist desk or the 
desk. Be careful not to have the wrist extended or 
bent in an up position. 

Screen placement 

 Set the eye to screen distance at the distance that permits you to most easily focus 
on the screen. Usually this will be within an arm's length. Set the height of the 
monitor so that the top of the screen is below eye level and the bottom of the 
screen can be read without a marked inclination of the head. Usually this means 
that the centre of the screen will need to be near shoulder height. Eyes level with 
the tool bar. People who wear bifocal or multi focal lenses will need to get a 
balance between where they see out of their lenses and avoid too much neck 
flexion. 

Desk-top layout 

 Place all controls and task materials within a comfortable reach of both hands so 
that there is no unnecessary twisting of any part of the body. Most people prefer 
the document holder to be between the keyboard and the monitor. There are many 
different types of document holders available. 

Document holder 

 Place this close to the monitor screen in the position that causes the least twisting 
or inclination of the head. 

Posture and environment 

 Change posture at frequent intervals to minimise fatigue. Avoid awkward postures 
at the extremes of the joint range, especially the wrists. Take frequent short rest 
breaks rather than infrequent longer ones. Avoid sharp increases in work rate. 
Changes should be gradual enough to ensure that the workload does not result in 
excessive fatigue. After prolonged absences from work the overall duration of 
periods of keyboard work should be increased gradually if conditions permit. 
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Lighting 

 Place the monitor to the side of the light source/s, not directly underneath. Try to 
site desks between rows of lights. If the lighting is fluorescent strip lighting, the 
sides of the desks should be parallel with the 
lights. Try not to put the screen near a 
window. If it is unavoidable ensure that 
neither the screen nor the operator faces the 
window. 

 If the monitor is well away from windows, 
there are no other sources of bright light and 
prolonged desk-work is the norm, use a low 
level of service light of 300 lux. If there are 
strongly contrasting light levels, then a 
moderate level of lighting of 400 – 500 lux 
may be desirable. 

Glare and reflection 

 It is important to detect the presence of glare and reflection. To determine whether 
there is glare from overhead lights whilst seated worker should hold an object such 
as a book above the eyes at eyebrow level and establish whether the screen image 
becomes clearer in the absence of overhead glare. To detect whether there are 
reflections from the desk surface, the worker should hold the book above the 
surface and assess the change in reflected glare from the screen. 

A number of ways are available to eliminate or reduce the influence of these reflections: 

 Tilt the screen (top part forwards) so that the reflections are directed below eye 
level. 

 Purchase an LCD screen. 

 Cover the screen with a light diffusing surface or anti-glare screen. 

 Negative contrast screen (dark characters on light background) will reduce the 
influence of these reflections. 

If you experience eye discomfort when using a bright screen you should make the following 
adjustments: 

 Turn the screen brightness down to a comfortable level. 

 Look away into the distance in order to rest the eyes for a short while every ten 
minutes or so. 

 Change the text and background colours. Recommended are black characters on 
white or yellow background, or yellow on black, white on black, white on blue and 
green on white. Avoid red and green and yellow on white. 
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Using a mouse 
 A well designed mouse should not cause undue pressure on the wrist and forearm 

muscles. A large bulky mouse may keep the wrist continuously bent at an 
uncomfortable angle. Pressure can be reduced by releasing the mouse at frequent 
intervals, by selecting a slim-line, low-profile mouse. 
Keep the mouse as close as possible to the keyboard, 
elbow bent and close to the body.  

Keyboard equipment and radiation 
 Computer screens emit visible light which allows the 

characters on the screen to be seen. Weak 
electromagnetic fields and very low levels of other 
radiation, not visible to the human eye, can be 
detected by sensitive instruments. Similar emissions 
are produced by television receivers. 

 The levels of most radiations and electromagnetic fields emitted from computers 
are much less than those from natural sources, such as the sun or even the human 
body and are well below levels considered to be harmful by responsible expert 
bodies such as the International Radiation Protection Association (IRPA). 

Keyboard and telephone operations  
 Avoid cradling the phone between your head and shoulder when answering calls. If 

needing to access the computer at the same time a headset is recommended. 
Hands free/speaker phone is another option if the environment is suitable.  

Posture during Keying 
 Good posture is essential for all users of computers. It comprises of a natural and 

relaxed position, providing opportunity for movement, and from which the 
operator can assume a number of alternative positions. It is not a single, rigidly 
defined position. 

Typing technique 
Typing is a physical activity, and using a keyboard requires skill, hence the need to learn correct 
typing technique. Unskilled ('hunt and peck') typists are particularly at risk of Occupational Overuse 
Injury because they: 

 Often use only one or two fingers which may overload the finger tendons; 

 Are constantly looking from keyboard to screen to keyboard, which may strain neck 
muscles; 

 Often adopt a tense posture (wrists bent back and fingers 'poised to strike'). 

 The University acknowledges the importance of learning correct typing technique. 
Departments should ensure that untrained staff receive appropriate training. 
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Speed of keying 

 The efficiency and speed of modern computers makes it 
possible for a skilled operator to type extremely quickly. 
This capability, reinforced by workload pressures means 
the potential exists for operators to key at speeds which 
may cause or contribute to Occupational Overuse 
Syndrome. 

 The role of the repetitive movement in injury is not fully 
understood, but is believed to interfere with the lubrication capacity of tendons, 
and the ability of muscles to receive sufficient oxygen supplies. 

10,000 – 12,000 keystrokes per hour is considered an acceptable standard. 

Length of time on the keyboard 

 The maintenance of a fixed posture for long periods is tiring and increases the 
likelihood of muscular aches and pains. In addition, long periods of repetitive 
movement and sustained visual attention can also give rise to fatigue-related 
complaints. 

 It is recommended that operators avoid spending more than five hours a day on 
keyboard duties and no longer than 50 minutes per hour without a 
postural/stretching break. 

 Employees newly engaged in keyboard work, and staff returning from an absence of 
two or more weeks, need a period of adjustment. The adjustment may be achieved 
through reduced work rates, or provision of alternate duties with gradual re-
introduction to keyboard work. 

Jobs should be designed and organised so that either: 

 Computer related tasks can be interspersed with non-computer related. 

 Computer based tasks can be rotated amongst several staff (task/job sharing). 

 It is not the change of task per se, but the change to using different movements and 
postures that is important. The whole purpose of task variety is to give the 
overloaded structures a necessary break. 

Supervisors should ensure that workload controls are exercised using the following strategies: 

 Planning ahead to avoid peaks, and rushed jobs. 

 Delegating fairly to all staff not just the best workers. 

 Considering the total workload of the individual (often comes from a number of 
sources). 

 Clearly defining each operator's workload. 

 Implementing systems of prioritisation e.g. work request forms, waiting lists. 
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 Using relief staff. 

 Applying strict tests to the use of urgent labels. 

 Discouraging endless drafts. 

 Discouraging the use of typed internal minutes and memoranda. 

 Encouraging authors to have realistic expectations. 

 Teaching authors keyboard skills. 

 Teaching operators how to be assertive, and how to prioritise. 

 Supporting operators when authors impose unrealistic expectations. 

 Refusing illegible drafts. 
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1.2 – Use energy and resource conservation techniques to minimise wastage 
in accordance with organisational and statutory requirements 

Conservation techniques may include: 

 Double-sided paper use 

 Recycling used and shredded paper 

 Re-using paper for rough drafts (observing confidentiality requirements) 

 Utilising power-save options for equipment. 

Energy and resource conservation in the workplace 
In Australia, on July 1st 2012 a carbon pricing system (tax) was 
introduced. 

This will see power price hikes in most parts of Australia. 

There are practical solutions to the energy costs that all businesses will 
incur.  

 Energy is part fixed cost and part variable cost and all organisations can exercise 
control over the amount of energy they use.  

 It comes down to looking at ways to reduce your energy consumption while 
maintaining suitable and ongoing conditions in your building or your office. 

 Consider engaging a consultant to conduct an audit and produce a report designed 
to your organisations energy needs.  

 Do not engage in an audit that is not specifically targeted to your needs otherwise 
you will end up with a giant list to choose from. 

 Don’t be surprised how bad things are as a result of an energy audit, as in Australia 
most organisations have experienced very cheap energy costs where bad energy 
wasting habits have been left unchecked. 

What are your energy efficiency priorities?  
 After completing an energy audit and having addressed the report, you will need to 

implement an energy management plan. 

 You may already have one and the audit will allow you a new approach to viewing 
the plan and prepare for carbon pricing system (tax) increases. 

 If nothing else, prioritise which ones you can do now. 
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What is an energy management plan?  

A plan in simple terms means:  

 Designing with your employees and suppliers a critical management tool that 
clearly articulates the measures that can and will be deployed by each department 
or team or individual to reduce energy usage. 

 The scope and coverage of your energy management plan can be developed for 
individual organisations, corporate entities or just for a single small operation. 

 Decide on the different priorities and levels of energy management each requires 
such as the size and complexity of the workplace. 

The audit results, as discussed above, can then be incorporated into your plan 

 Where, how and why is the energy being consumed?  

 What specific measures can you introduce to reduce consumption and how will 
they be implemented in the short, medium and longer terms?  

 How will these measures be resourced and funded?  

 What are the direct benefits and what are the associated risks? 

 What are the advantages and disadvantages?  

 Will the energy consumption reduction measures impact on your 
product or service delivery?  

 What new roles and responsibilities will employees have within the 
organisation?  

 How will relevant information and data be recorded and reported? 
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1.3 – Identify spreadsheet task requirements and clarify with relevant 
personnel as required 

 Data entry 

 Storage 

 Output 

 Presentation 

Identify the task? 
Use spreadsheets to list and maintain groups of 
numerically based data 

Most general purpose information projects can 
be implemented with either a spreadsheet or a 
relational database 

You can automatically create charts out of 
spreadsheet data, which you can then print or 
easily import into presentation applications. 

Ease of Use: In fact, some would say that this is 
in fact the problem with spreadsheets! It is just 
too easy to knock together a new report without 
having to think about the big picture. 

A spreadsheet can also be handy for simple data 
entry, because you can press the Tab key to 
easily advance from cell to cell, and the data are 
simply laid out in rows and columns.  

The latest versions of Excel have stunning 
presentation facilities and they also connect very 
easily to Word or PowerPoint. 

Organisational task requirements 
 As the task and any organisational requirement in this instance may be 

hypothetical, it can be assumed that the challenge here is to firstly assume that we 
are talking about recording and evaluating data that a spreadsheet would likely 
serve as your number one choice as described above. 

 In reality, however, there may be several other more suitable application options 
within your organisation such as word docs, major data base applications and other 
computerised formats for recording, storage, generating output, reporting and 
subsequent presentation requirements. 

Spreadsheet specifications 
 The structure of tables, as one example, is determined by different kinds of cells 

and their relationships. For example, the cells of a table can be distinguished 
according to their content into header, data, and computation cells. Moreover, 
some rows or columns of a table are fixed, like header and footer rows and 
columns, while other rows and columns are duplicated if new data is to be added. 
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Data entry, storage, output, reporting and presentation requirements 
Data entry 

Using a form for data entry in excel 

 

 

 

 

 

 

 

 

 

 

Storage 
 Spreadsheet applications can appear somewhat intimidating to uninitiated users, 

and this overwhelming initial appearance can lead users to use the applications for 
unintended purposes.  

 Users should employ spreadsheet applications only for purposes of short-term data 
compilation and analysis, not for the long-term data storage that many users may 
attempt. 

 Specific data bases are best used for longer and more sophisticated storage needs. 

Output 
 Spreadsheets are very handy tools in data output as they can help the user to do 

simple computations and checks on the data input.  

 Simple statistical analysis and statistical parameters like mean, median, mode and 
range, etc. can be easily found using spreadsheet formulas. 

 Data output is a process by which data can be studied under different 
circumstances and manipulated as required by the user.  

 Any statistical analysis produces an output data that needs to be studied. This data 
needs to be modified in a presentable form so that further conclusions and 
inferences can be drawn by the team and other parties. 
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 As more software is developed there are many programs that help with data 
output. These tools can be used by the team to present the findings in different 
formats and also helps to do the required calculations on the data. 

Presentation 
 Spreadsheets are designed to record, sort, calculate and store data. There are, 

however, times when you need to add graphics in order to communicate the 
information more effectively. 

 You might, for example, like to add graphics, photos or other enhancements to add 
to the presentation format of a report or spreadsheet on a PC. 

 It’s often not realised that graphics can be substituted for the vertical bars in a 
column chart.  

 Perhaps the best way to enhance spreadsheet style is to project a spreadsheet on a 
screen and invite discussion about how its readability may be improved. 
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2. Create simple spreadsheets 

2.1 – Ensure data is entered, checked and amended in accordance with 
organisational and task requirements, to maintain consistency of design and 
layout 

Data may include: 

 Numbers 

 Text 

Checking data may include: 

 Accuracy of data 

 Accuracy of formulae with calculator 

 Ensuring instructions with regard to content and format have been followed 

 Proofreading 

 Spelling, electronically and manually 

Ensure data is entered, checked and amended to maintain consistency 
 Depending on your workplace needs, the creation of a spreadsheet by inserting 

data, be it text or numbers will require some degree of checking for accuracy, 
consistency or whatever the requirement of your organisation has in place. 

Example 
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Accuracy of data 
 Sometimes you may not want data to repeat itself.  

 On an order form or an inventory sheet, for instance, you may not want a part 
number entered in one cell to repeat in another cell.  

 You can use Excel's Data Validation to prevent a value from appearing more than 
once in a range. 

You use data validation to control the type of data or the values that users enter into a cell.  

For example: 

 You may want to restrict data entry to a certain range of dates, limit choices by 
using a list, or make sure that only positive whole numbers are entered. 

 Among other things, you can use data validation to restrict data to predefined items 
in a list such as types of departments to Sales, Finance, R&D, and IT.  

 Similarly, you can create a list of values from a range of cells elsewhere in the 
worksheet. 
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Accuracy of formulae with calculator 
NOTE: The plural of formula in English is formulae. 

Calculation in Excel is the process of computing a formula and then displaying the result as a value in 
the cell that contain that formula.  

 To avoid unnecessary calculations, Microsoft Office Excel automatically recalculates 
formulas only when the cells that the formula depends on have changed.  

 This is the default behaviour when you first open a workbook and when you are 
editing a workbook. However, you can control when and how Excel recalculates 
formulas. 

Iteration in Excel is the repeated recalculation of a worksheet until a specific numeric condition is 
met.  

 Excel cannot automatically calculate a formula that refers to the cell — either 
directly or indirectly — that contains the formula.  

 This is called a circular reference. If a formula refers back to one of its own cells, you 
must determine how many times the formula should recalculate.  

 Circular references can iterate indefinitely. However, you can control the maximum 
number of iterations and the amount of acceptable change. 

Precision in Excel is a measure of the degree of accuracy for a calculation.  

 Excel stores and calculates with 15 significant digits of precision.  

 However, you can change the precision of calculations so that Excel uses the 
displayed value instead of the stored value when it recalculates formulas. 

Basic mathematical operations such as addition, subtraction, or multiplication. 

 Use the following arithmetic operators. 

Formula Looks like 

=SUM  
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= A1+A2 

    
Subtraction – minus sign ( – ) 
Addition – plus sign ( + ) 
Division – forward slash ( / ) 
Multiplication – asterisk ( * ) 
Exponentiation – caret ( ^ ) (The operation of raising one quantity to the power of another) 
Excel Order of Operations 

If more than one operator is used in a formula, there is a specific order that Excel will follow to 
perform these mathematical operations. This order of operations can be changed by adding brackets 
to the equation. An easy way to remember the order of operations is to use the acronym: 

BEDMAS 
The Order of Operations is: 

 Brackets 

 Exponents 

 Division 

 Multiplication 

 Addition 

 Subtraction 

 

Ensuring instructions with regard to content and format have been followed 

Depending on the instructions, there could be several requirements to follow content and format 
protocols. 

Content 

To display the contents of a worksheet cell in a shape, text box, or chart element, you can link the 
shape, text box, or chart element to the cell that contains the data that you want to display.  

Using the Camera command, you can also display the contents of a cell range by linking the cell range 
to a picture. 

You can split the contents of one or more cells in a column and distribute those contents as individual 
parts across other cells in adjacent columns. 

For example, your worksheet contains a column of full names that you want to split into separate first 
name and last name columns. 

Select the cell, range, or entire column that contains the text values that you want to split. 
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Format 

You can save a Microsoft Excel 2010 file in another file format by clicking the File tab, and then 
clicking Save As. The file formats that are available in the Save As dialog box vary, depending on what 
type of sheet is active (a worksheet, chart sheet, or other type of sheet). 

In Excel 2010, you can open a file that was created in another file format, either in an earlier version 
of Excel or in another program, by clicking the File tab, and then clicking Open. If you open an Excel 
97-2003 workbook, it automatically opens in Compatibility Mode. To take advantage of the new 
features of Excel 2010, you can save the workbook to an Excel 2010 file format. However, you also 
have the option to continue to work in Compatibility Mode, which retains the original file format for 
backward compatibility. 

Format Extension Description 

Excel Workbook .xlsx The default XML-based file format for Excel 2010 and Excel 
2007. Cannot store Microsoft Visual Basic for Applications (VBA) 
macro code or Microsoft Office Excel 4.0 macro sheets (.xlm). 

Excel 97- Excel 
2003 Workbook 

.xls The Excel 97 – Excel 2003 Binary file format (BIFF8). 

XML Spreadsheet 
2003 

Xml XML Spreadsheet 2003 file format (XMLSS). 

Other formatting requirements 

 You can add content or apply formatting to two or more of the sheets on a multi-sheet 
worksheet by "grouping" the sheets together.  

 When you group multiple sheets, any content or formatting that you add to one sheet also 
gets added to all the other sheets, so you can add a row of headers to one sheet and have it 
automatically appear on all the sheets that are grouped together with it.  

 To group all the sheets in a worksheet, right-click on any of the tabs in the lower left of the 
window, and click Select All Sheets.  

 If you only want to select two or more individual sheets, hold down the Ctrl key and click on 
the tabs of the sheets that you want to format or edit at the same time.  

 When two or more sheets are grouped, Excel adds the word "[Group]" (in square brackets) 
after the sheet's name in the title bar. 
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Proofreading 
 

 If you are asked to proofread or collaborate on a worksheet someone else has 
written you might use a red pen to cross out cell data, mark misspellings, or add 
comments in the margins.  

 In Excel 2010 you can do all of these things using the Track Changes and Comments 
features. 

 Change tracking is available only in shared workbooks. In fact, when you turn on 
change tracking, the workbook automatically becomes a shared workbook 

 

 

 

 

 

 

Excel can speak the cell contents to assist proofreading 

 Instead of looking between a hard copy of data and comparing it to the data 
entered on the spreadsheet you can make Excel read your spreadsheet to you while 
you are looking at the hard copy version. 
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Use Excel's Text to Speech feature to do your proofreading 

 

 Next to the Quick Access 
Toolbar, click Customize 
Quick Access Toolbar 

 Click More Commands 
 In the Choose commands 

from list, select All 
Commands 

 Scroll down, and for each 
text-to-speech command 
that you want to use, click 
the Speak Cells command, 
and then click Add. 

 Click OK. 

When you want to use a text-to-
speech command, click it on the 
Quick Access Toolbar 

 

Spelling (Excel 2010) 

 Click on File to open the menu 
 Click on Options 
 When the Word Options window 

opens, click on Proofing on the left 
pane 

 Click on the AutoCorrect Options 
button 
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To check the spelling in a worksheet, follow these steps: 

 Click the Spelling command button in the Proofing group of the Review tab (or press 
F7). 

 Excel begins checking the spelling of text entries in the worksheet. When the 
program comes across an unknown word, it displays the Spelling dialog box. 

 

 Excel suggests replacements for the unknown word shown in the Not in Dictionary 
text box with a likely replacement in the Suggestions list box. If that replacement is 
incorrect, you can scroll through the Suggestions list and click the correct 
replacement. 

Select one or more of the following dialog box options: 

 Ignore Once or Ignore All: When Excel’s spell check comes across a word its 
dictionary finds suspicious but you know is viable, click the Ignore Once button. If 
you don’t want the spell checker to query you about this word again, click Ignore 
All. 

 Add to Dictionary: Click this button to add the unknown word — such as your name 
— to a custom dictionary so that Excel won’t flag it again. 

 Change: Click this button to replace the word listed in the Not in Dictionary text box 
with the selected word in the Suggestions list box. 

 Change All: Click this button to change all occurrences of this misspelled word in the 
worksheet to the selected word in the Suggestions list box. 

 AutoCorrect: Click this button to have Excel automatically correct this spelling error 
with the selected suggestion in the Suggestions list box (by adding the misspelling 
and suggestion to the AutoCorrect dialog box). 
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2.2 – Format spreadsheet using software functions; to adjust page and cell 
layout to meet information requirements, in accordance with organisational 
style and presentation requirements 

Formatting may include: 

 Alignment on page 

 Efficiency of formulae 

 Enhancements to format – borders, patterns and colours 

 Enhancements to text 

 Headers/footers 

 Use of absolute and relative cell addresses 

 Use of cell addresses in formulae 

Software functions may include: 

 Adding/deleting columns/rows 

 Formatting cells 

 Formatting text 

 Headers/footers 

 Sizing columns/rows 

The practical application of all of these functions will depend on the workplace situation, the 
individual needs of the application and the context of the organisation need, e.g., records, lists 
comparative charts etc. 
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2.3 – Ensure formulae are used and tested to confirm output meets task 
requirements, in consultation with appropriate personnel as required 

Formulae may include: 

 Absolute cell referencing and/or mixed references 

 Average 

 Division 

 Maximum 

 Minimum 

 Multiplication 

 Subtraction 

 Sum 

 Combinations of above 

Use cell or sheet auditing feature to check formulae 
 

Normal View Auditing View 
 

AUSTRALIS 
WATCH 

  
300 250 
120 100 
30 25 
39 32 
17 14 

206 171 

AUSTRALIS WATCH 

   
300 250 

=B32*F33 =C32*F33 
=B32*F34 =C32*F34 
=B32*F35 =C32*F35 
=B32*F36 =C32*F36 

=SUM(B33:B36) 171.428571428571 
 

 

 

 

 

 

 

 



P a g e  | 28 
 

Normal View 

member 
standard 

non 
member 
standard     

37% of $1800 37% of 
$2138 

37% is 
historical    

$666 $791     
  0.00  0.00 0.00 

  0.00  0.00 0.00 
$0  0.00  0.00 0.00 

 $0 0.00  0.00 0.00 

  0.00  0.00 0.00 
 

 

 

 

Auditing View 

member standard 
Non-member 

standard  
37% of $1800 37% of $2138 37% is historical 

666 791  
  =J75 

  =J76 
=C77*A74  =J77 

 =C78*B74 =J78 

  =SUM(C75:C78) 
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2.4 – Use manuals, user documentation and online help to overcome 
problems with spreadsheet design and production 

Manuals Provide a complete how to instruction in manual format! 

 Getting Started  

 Definitions  

 Ribbon  

 Navigating Cells  

 Data  

 Entering Data/Text  

 Editing Data/Text  

 Autofill  

 Controlling Your View of Data  

 Sorting and Filtering  

 Formulae 

 Cell References Autofill with Formulae 

 AutoSum  

 Functions  

 AutoCalculate  

 Name Manager  

 Charts  

 Pivot table  

 Trouble-shooting  

 Printing  

User 
documentation 

Resources 

For more information about Office Excel 2010, please visit: 

Office Excel 2010  

http://www.microsoft.com/office/excel 

Online help 

 

 

http://www.microsoft.com/office/excel
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Didn't find what you were looking for here? 

Search the Microsoft Answers forum to get help from others in the Office community. 
 

 

 
 

3. Produce simple charts 

3.1 – Select chart type and design that enables valid representation of 
numerical data and meets organisational and task requirements 

3.2 – Create chart using appropriate data range in spreadsheet 
 

Chart types may include: 

 Area 

 Bar 

 Column 

 Exploded pie  

 Line 

 Pie and 3D pie 

 Scatter/bubble 

 Stacked/multiple bar 

 Stacked, 3D column 

Selecting the most effective chart type will make your data clearer, stronger, and more informative.  
 
Microsoft Office Excel offers a wide variety of chart types and simple methods for selecting and 
previewing them. 

Select chart type and design that enables valid representation of numerical data 

 Selecting the most effective chart type will make your data clearer, stronger, and 
more informative.  

 Microsoft Office Excel offers a wide variety of chart types and simple methods for 
selecting and previewing them. 

 There are many ways to enhance a chart to emphasise the point or purpose and to 
improve readability.  

http://office.microsoft.com/en-au/excel-help/
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 Usually, Graphs and Charts are used for representing and organising a set of 
numerical data with a graphical representation such as pie chart, line charts, bar 
graphs and many more. 

 With so many chart types available, how do you know which is best for you? Keep in 
mind, the point is to get your message across in the most effective way. 

 
Meeting your organisational and task requirements will require the instructor to detail what that 
actually represents. 

 Different chart types can deliver different messages about the same data.  

 It's like several versions of a single story. 

In Excel, there is a selection of chart options. 
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A Column chart is a good type for comparing values 
directly, and you want to compare how many cases each 
salesperson sold, so it's a good fit.  

When choosing a chart type, it's often wise to keep it 
simple, so that your message comes across clearly. 

 

As you can see in the chart above, Peacock sold the most 
cases in January and February, but Suyama pulled ahead in 
March. The sizes and colours of the columns tell the story 
at a glance. 

 

Examples of numerical placement in a Chart 
Data used in 
this example:      
        Sales (in $000) 
Product Code 2010 2011 2012 2013 2014 
Excel  $ 175   $ 200   $ 250   $ 300   $ 350  
Power Point  $ 100   $ 125   $ 170   $ 200   $ 275  
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Word  $ 300   $ 350   $ 400   $ 450   $ 525  
Outlook  $ 275   $ 250   $ 350   $ 325   $ 375  

      

 

 

 

 

3.3 – Modify chart type and layout using formatting features 

Features may include: 

 Axes 
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 Axis title 

 Borders 

 Chart title 

 Colours 

 Data labels 

 Data tables 

 Fills 

 Gridlines 

 Legend 

 Lines 

 Patterns 

After you create a chart, you can instantly change its look.  

Instead of manually adding or changing chart elements or formatting the chart, you can quickly 
apply a predefined layout and style to your chart.  

 Microsoft Office Excel provides a variety of useful predefined layouts and styles (or 
quick layouts and quick styles) that you can select from.  

 You can do more with your data than create one chart. You can make your chart 
compare data another way by clicking a button to switch the chart view from one 
view to another. 

 However, you can customise a layout or style of a chart further by manually 
changing the layout and style of the individual chart elements that are used in the 
chart. 

 You cannot save a custom layout or format, but if you want to use the same layout 
or format again, you can save the chart as a chart template. 
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Change the layout of chart elements manually 

1. Click the chart, or do the following to select the chart element for which you want 
to change the layout from a list of chart elements: 

a) Click a chart. 

TIP This displays the Chart Tools, adding the Design, Layout, and 

Format tabs.  

2. On the Format tab, in the Current Selection group, click 
the arrow next to the Chart Elements box, and then 
click the chart element that you want. 

3. On the Format tab, in the Current Selection group, click 
the arrow next to the Chart Elements box, and then click the chart element that you 
want. 

 

 

 

 

 

 

 

 

 

 

4. On the Layout tab, do the one or more of the following: 

o In the Labels group, click the label layout option that you want. 
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o In the Axes group, click the axis or gridline option that you want. 

o In the Background group, click the layout option that you want. 

NOTE The layout options that you select are applied to the element that you have selected. For 
example, if you have the whole chart selected data labels will be applied to all data series. If you have 
a single data point selected, data labels will only be applied to the selected data series or data point. 

Select a predefined chart style 
1. Click the chart that you want to format. 

 TIP This displays the Chart Tools, adding the Design, Layout, and Format tabs. 

2. On the Design tab, in the Chart Styles group, click the chart style that you want to 
use. 

 TIP To see all predefined chart styles, click More  

NOTE When the Excel window is reduced in size, chart styles will be available in the Chart Quick 
Styles gallery in the Chart Styles group. 

 TIP Chart styles use the colours of the current document theme that is applied to the workbook. You 
can change the colours by switching to a different document theme. You can also customize a 
document them to display a chart in the exact colours that you want.  
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Select a predefined chart layout 
1. Click the chart that you want to format.  

 TIP This displays the Chart Tools, adding the Design, Layout, and Format tabs. 

2. On the Design tab, in the Chart Layouts group, click the chart layout that you want 
to use. 

 

 

 

 

 

 

 NOTE When the Excel window is reduced in size, chart layouts will be available in the Quick 
Layout gallery in the Chart Layouts group. 

 TIP To see all available layouts, click More  

4. Finalise spreadsheets 

4.1 – Ensure spreadsheet and any accompanying charts are previewed, 
adjusted and printed in accordance with organisational and task 
requirements 

Printing may include: 

 Fit on one page 

 Fit specific number of pages 

 With formulae 

 With values 
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Previewing spreadsheets (Excel 2010) 
 

Adjust and print 
spreadsheet 

 Before you print a chart, you can adjust where the chart will print on the page by 
moving and sizing the chart in Page Layout or Page Break Preview view.  

 You can also quickly print a chart without the worksheet data. 

 For faster printing, you can change the print quality of the chart to draft quality or 
black and white printing. 

 
Print a chart without worksheet data 

You can print one chart without worksheet data per page. 

1. Click the chart that you want to print. 

 TIP If the chart is on a separate chart sheet, click the chart sheet tab. 

2. Click the Excel 2010 button , and then click Print.  

By default, the selected chart is displayed to see how the chart will look on the printed page. 

 NOTE You cannot scale a chart before you print it. Instead, you can move and size the chart area of 
the chart to adjust is as needed.  

Set page options for a chart 
1. On the Page Layout tab, in the Page Setup group, click the Dialog Box Launcher  

javascript:AppendPopup(this,'750557156_1')


P a g e  | 39 
 

 

2. Do one or more of the following: 

o On the Page tab, specify the orientation, paper size, print quality, and the 
page number of the first page. 

 NOTE You cannot adjust the scaling of a chart. 

 TIP To quickly specify the orientation of the printed pages, on the Page Layout tab, in the Page 
Setup group, click Orientation, and then click Portrait or Landscape. 

Print a chart with worksheet data 
1. Click the worksheet that contains the chart that you want to print. 

2. On the View tab, in the Workbook Views group, click Page Layout or Page Break 
Preview.  

3. To move the chart, drag it to a preferred location on the page that you want to 
print. 

4. To resize the chart, click the chart, and then drag the sizing handles to the size that 
you want. 

TIP If a worksheet contains more than one chart, you may be 
able to print the charts on one page by reducing the size of the 
charts. 

5. Click the worksheet. 

6. Click the Excel 2010  Button, and then 

click Print  

 NOTE By default, cell gridlines are not printed on a worksheet. To print the worksheet with cell 
gridlines displayed, see Print with or without cell gridlines 

Printing 
 By default, Excel prints worksheets in portrait orientation (taller than wide).  

http://office.microsoft.com/en-us/excel-help/redir/HP010021543.aspx?CTT=5&origin=HP001233755
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 You can change the page orientation to landscape (wider than tall) on a worksheet-
by-worksheet basis.  

 If you always want to print worksheets in landscape orientation, you can create a 
template, change the page orientation from portrait to landscape, and then use 
that template as the basis for all future workbooks. 

 

NOTE Because you can set page orientation on a worksheet-by-worksheet basis, it is possible to print 
some worksheets in a workbook in one orientation (such as portrait orientation) and other 
worksheets in the same workbook in the opposite orientation (such as landscape orientation).  

Simply set the orientation for each worksheet as appropriate, and then print the entire workbook. 

Prints the whole worksheet 
 

 

 

 

Print a partial or 
entire worksheet or 

workbook 

1. Do one of the following: 

o To print a partial worksheet, click the worksheet, and then select the range 
of data that you want to print. 

o To print the entire worksheet, click the worksheet to activate it. 

o To print a workbook, click any of its worksheets. 

o Click the Excel 2010  Button, and then click Print  
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Keyboard shortcut: You can also press CTRL+P. 

2. Under Print what, select an option to print the selection, the active sheet or sheets, 
or the entire workbook. 

 

 NOTE If a worksheet has a defined print area, Excel will print only the print area. If you don't want 

to print a defined print area, select the Ignore print areas check box. 

4.2 – Ensure data input meets designated timelines and organisational 
requirements for speed and accuracy 

Designated time lines may include: 

 Organisational time line e.g. financial requirements. 

 Time line agreed with internal/external client. 

 Time line agreed with 
supervisor/person requiring 
spreadsheet. 

Designated time lines may be: 

 By month end 

 Monthly 

 Within agreed period 

 Within organisational deadline 

General administration timelines can be met if you observe common sense principles: 

1. Determine when the task must be accomplished by you.  

2. This becomes your end point on the timeline.  
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3. Calculate how long you have from the current date until the deadline arrives. 

4. Write down specifically what needs to be done by the deadline. 

For example, determine exactly the data input needs that are drawn from a range of sources 
either within your organisation or from external providers. 

1. Divide the goal into smaller logical steps.  

2. Think about what individual actions you need to take in order to get to the end 
result you defined.  

3. Estimate how much time each step will take to complete. Use prior experience or 
your knowledge of the amount of work involved in processing the data. 

4. Add up your time estimates to determine if the total time needed fits within the 
actual amount of time you have left or what has been determined as organisational 
requirements for speed and accuracy.  

5. If not, adjust the time lengths for each step as necessary to fit the timeline. 

6. Monitor your progress on each smaller step and toward the end goal at regular 
intervals. Make any adjustments to the timeline as necessary if you fall behind or 
get ahead of the estimated due dates. 

 

4.3 – Name and store spreadsheet in accordance with organisational 
requirements and exit application without data loss/damage 
 

Naming and storing spreadsheet may include: 

 Authorised access 

 File naming conventions 

 Filing locations 

 Organisational policy for backing up files 

 Organisational policy for filing hard copies of spreadsheets 

 Security 

 Storage in electronic folders/sub-folders 

 Storage on CD-ROM, USB, tape back-up, server 

Naming and storing spreadsheet may include 

The Open XML file formats and their extensions are used by Microsoft Word 2010, Microsoft Excel 
2010, and Microsoft PowerPoint 2010. 

Excel 2010 or Office 

Excel Workbook. xlsx The default Excel file format. Cannot store VBA macro code or Microsoft Excel 
4.0 macro sheets (.xlm files in Excel 4.0). 
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Excel Macro-Enabled Workbook. .xlsm. Uses the same basic XML format as the Excel Workbook, but 
can store VBA macro code. Users saving an Excel workbook that has VBA code or Excel 4.0 macro 
sheets (.xlm files in Excel 4.0) are prompted to use this file format. 

EXCEL 

XML FILE TYPE EXTENSION 

Workbook .xlsx 

Macro-enabled workbook .xlsm 

Template .xltx 

Macro-enabled template .xltm 

Non-XML binary workbook .xlsb 

Macro-enabled add-in .xlam 
 

 

Filing locations 
You can keep track of when records in a table are last modified, by using a form with a macro. When 
the form is used to modify a record, the macro stores the date and time in the table. Only the most 
recent modification date and time are stored. 

The My Places bar is on the left side of some dialog boxes, such as Save As, Open, and Insert Picture, 
that allows you to specify a folder where you want to store your files. You can use the My Places bar 
to help save time getting to your folders and help make it easier to access your files in your various 
folders. After you update the My Places bar in one dialog box, the changes are available in the other 
dialog boxes with the My Places bar. 

Security 
Viruses, worms, Trojan horses, phishing, and spyware are security threats to your computer and 
data. 

 Virus Software (or code) written with the express intention of replicating itself. A 
virus attempts to spread from computer to computer by attaching itself to another 
file or program. 

 Worm Software that replicates independently by sending itself to other systems 
through network connections. 

 Trojan horse Software that appears to be useful or harmless but that contains 
hidden code designed to exploit or damage the system on which it is run. 

 Spyware  Software that can display advertisements (such as pop-up ads), collect 
information about you, or change settings on your computer, generally without 
appropriately obtaining your consent. You usually download spyware without 
knowing it by visiting untrustworthy Web sites. 

 Phishing A way of extracting personal information from you such as bank or credit 
card details, normally done via e-mail. There are also some phishing schemes 
designed to put spyware on your computer. The good news is that Outlook 2010 
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has anti-phishing features. 

What are your storage needs? 
 All organisations, large and small, need more space for data storage.  

 Documentation in the form of e-mails, word 
documents, presentations, databases, 
graphics, audio files and excel spreadsheets is 
the lifeblood of most organisations. 

 As the applications that run and protect your 
business require more and more memory and 
space so does the growth of storage options 
and storage protocols. 

 The protocols and procedures for saving files, storing and backup are usually part of 
an operating policy so the organisation can minimise loss of data. 

 Assess your storage needs associated with each application, the data it is producing 
and how and where you will access that data. 

Exit the application without data loss/damage 

 You can close each of these workbook windows one at 
a time, or you can close the whole workbook (including 
all of its workbook windows). To close all workbooks 
that are open, you can close the Excel window or exit 
Excel. 

Close the active workbook window 

1. Click the workbook window that you want to close. 

2. In the upper-right corner of the workbook window, click Close Window. 

 NOTE If the window is the only open window of the workbook, the whole workbook is closed. If 

there are more workbook windows of the same workbook, only the active workbook window is 
closed. 

Close a workbook 

 Activate the workbook that you want to close. 

 Click the Excel 2010  Button 

 Click the  Button. 

Close all workbooks and exit Excel without data loss/damage 
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Do one of the following: 

 In the upper-right corner of the Excel window, click Close Window  

 Click the Excel 2010  Button 

 Click the  Button. 

Prevent data loss: 

 Never store your documents on the same drive as your operating system 

 Back up your files regularly, no matter where they're stored 

 Beware of email attachments 

 Beware of user error 

 Keep hardcopies of your documents 

References 
 

These suggested references are for further reading and do not necessarily represent the contents 
of this learners guide 

 

 Excel 2007 Bible [Paperback], John Walkenbach (Author) 

 Excel 2007 Formulas (Mr. Spreadsheet's Bookshelf) [Paperback], John Walkenbach (Author) 

 Learn Excel 2007 Essential Skills with The Smart Method: Courseware tutorial for self-
instruction to beginner and intermediate level [Paperback], Mike Smart (Author) 

 Microsoft® Office Excel® 2007 Step by Step (Step By Step (Microsoft)) [Paperback], Curtis 
Frye (Author) 
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